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Last Meeting - September 13:
The September Meeting commenced with our Annual General Meeting. 
You will see from the Committee list at the left, that a new Team has taken over the Leadership of the Club.
A question and answer Session followed, with members of the Committee forming a panel.

  BMUG PDF Newsletter — October 2011

Next Meeting:
Tuesday October 11, 4.00 pm at St Peter’s Hall,corner Draper and Hodgson Streets, Ocean Grove.

 

Making the most of Apps 
David Dixon will deliver a presentation on Apps for the Mac.  Members will have plenty of time to describe their 
favourite App’s and or ask questions.
At the end of the meeting, time permitting, a summary will be presented to the membership.
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Apple announcement on Steve Jobs's death
October 6, 2011 - 11:14AM

Apple has announced its former chief  executive Steve Jobs has died. Mr Jobs, who stepped down recently as chief  
executive, had been suffering from pancreatic cancer. 

”We are deeply saddened to announce that Steve Jobs passed 
away today.

Steve's brilliance, passion and energy were the source of countless 
innovations that enrich and improve all of our lives. The world is 
immeasurably better because of Steve.

His greatest love was for his wife, Laurene, and his family. Our 
hearts go out to them and to all who were touched by his 
extraordinary gifts.”

We at BMUG place on record our sincere condolences to Steve’s 
family. Over the past few years we have been fortunate to be the recipients of numerous new products 
developed by Apple as a result of the drive, lateral thinking and determination of Steve in his position 
as CEO of Apple. We have derived a great deal of pleasure and improvement in our lifestyles by using 
these products. 
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Balance of our Program for 2011
             
November:
Groups will discuss Travelling 
with your devices - Macbook, 
iPhone, iPod and iPad.

December:
Show & Tell, followed by our 
Christmas Breakup. 
If you have something of 
interest relating to Apple/Mac  
products or Software, this is 
your opportunity to make a 
presentation.
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      BMUG Committee Duties, 2011-12
The following is a list of your Committee Members and their duties. 
Despite the extra workload, these members are keen to serve on the Committee, as participation gives them a great 
opportunity to extend their interest in Macs and share their enthusiasm with others. 
The Committee is still looking for at least one more member to complete the number required by our Constitution and 
also to reduce the work load on existing Committee members. 
Please give this matter your earnest consideration.

Name Position Duties

David Dixon President Presidential Tasks: Open & Close Meetings, Chair Committee Meetings.
Welcome Letter to new members & Manuals Printing.
Hall Bookings.

Peter Baldwin Vice President Newsletter Editor.
Library Buyer & Co-Ordinator.
Email Secretary.

Ian Little Treasurer Treasurer, & associated financial tasks.

Pat Hollis Secretary & 
Membership

Membership & Secretarial tasks.
Prepare Agenda for Committee Meetings.
Take and distribute Committee minutes.

Jurgen Gross Committee Member BMUG Assist Co-Ordinator.
Help Desk Co-Ordinator.

Greg Melville Committee Member Hall set-up & put away co-ordinator.
Meet & Greet.

Peter Oakley Committee Member Membership Assist

Prue Patterson Committee Member Web Manager.
Remote Member Representative.
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What is “AirDrop” in OS X Lion?

AirDrop is a welcome new feature in Lion 
that makes it easy to share files with other 
Mac OS X Lion users.
Click on “AirDrop” in the Finder’s side panel and you will 
see a screen of concentric “radar” rings with your Mac in the 
middle. 
Any Mac nearby running Lion will now be able to see you by 
also launching “AirDrop”, whereupon their icon-identity 
appears on your screen. 
Either of you may now send files to the other by dragging 
them on to the destination icon. It is very fast, moving about 
1Mb per second, and it requires no laborious setting up. 
OS X Lion has automated local networking.
AirDrop is a peer-to-peer system that uses the wi-fi receiver 
transmitters in the Macs, not an external wi-fi access point. 
This is why PC users cannot see you but other nearby Macs 
can. 
However, for extra security, files are encrypted for 
transmission and nothing moves unless you click the 
“accept” button.

OS X Lion introduces new hidden 
Tools in Mail:

The messages in Mail now have a line just 
below the header. If you hover the cursor on 

the line you can see icons for Trash, Reply, and 
Forward. Tap the Trackpad to command.

! ! ! ! ! ! Peter Baldwin

Dear Aunty Mac,

Recently on the radio there was a warning about "in app 
charges" where, for instance, a free downloaded game might 
involve washing a dog. The player buys soap and dog food 
with what they think is "play money" but it is a real charge 
against a credit card. Later on, when the card statement 
arrives there can be many hundreds of dollars paid for in the 
game.   
Here are some references:

http://www.media.tas.gov.au/release.php?id=33149

http://tidbits.com/article/11650

http://www.washingtonpost.com/wp-dyn/content/
article/2011/02/08/AR2011020804035.html

Might be a good idea for the newsletter and discussion at a 
meeting.
! ! ! ! ! ! Alan McGuire

Thanks for your contribution Alan, I will ensure that this subject 
is listed for discussion at our next Planning Committee 
Meeting.! ! ! ! !
! ! ! ! ! ! Peter

  Another Useful Tip-
When you delete items from your USB stick and move them to 
Trash on your computer, you must empty your Trash file on the 
computer whilst the USB stick remains in the computer’s USB Port . 
If you do not do this, when you re-plug your USB stick back into the 
computer the deleted items from the USB stick re-appear in Trash, 
even though the USB stick shows no sign of these deleted items.
! !

! ! ! ! ! ! ! ! ! ! Peter Baldwin

http://www.media.tas.gov.au/release.php?id=33149
http://www.media.tas.gov.au/release.php?id=33149
http://tidbits.com/article/11650
http://tidbits.com/article/11650
http://www.washingtonpost.com/wp-dyn/content/article/2011/02/08/AR2011020804035.html
http://www.washingtonpost.com/wp-dyn/content/article/2011/02/08/AR2011020804035.html
http://www.washingtonpost.com/wp-dyn/content/article/2011/02/08/AR2011020804035.html
http://www.washingtonpost.com/wp-dyn/content/article/2011/02/08/AR2011020804035.html
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The Age of Streaming
  What does it mean...

GLOSSARY:
Streaming Audio: A technology that lets you listen to 
music and other types of sound files in real time over the 
internet without having to download.
Podcast: Non-streamed webcasts. Typically a complete 
episode or program of music, an interview, a review or news 
made available on the internet for downloading.
Internet radio: Radio broadcast exclusively over the 
internet as a webcast and unregulated except for music 
copyright laws.

Digital radio: Free and broadcast over the 
airwaves like AM and FM but you need a DAB
+digital radio receiver.

Here is an App to personalise your Mac
Have you noticed how difficult it is to find one of your folders 
amongst a whole selection all showing a blue icon? 
Well, here is your answer!
Img2icns is a free App which allows you to create icons from 
images or images from icons. 
Creating an icon is as simple as dropping one or more images 
into Img2icns and choosing an export format. 
!
Apply icons to your files 
Drop an image onto Img2incs, then drop all the files where you 
want the icon changed on the preview box, the icon will be 
applied immediately.

Here is a sample from my Documents Folder-

     Peter Baldwin
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Product Review

Roxio Toast 11 Titanium
Publisher: Roxio - released August 
2011

This Application offers the most 
comprehensive set of features, 

supports multilingual documentation and has an easy-to-use 
interface. All these features make it the best Mac CD burning 
application. 
However, it is one of the more expensive burning solutions 
available for Mac, with a list price of $179.00. You may be 
able to obtain it cheaper by researching the various retail 
outlets.

The main features offered in Toast 11 Titanium are -

• Capture audio & video from the web, camcorders, DVD’s, 
and LPs;

• Copy discs with one click, create custom DVD and HD 
compilations;

• Convert your media for playback on iPad™, iPhone® and 
more;

• Share your video directly to You Tube™, facebook®, 
Vimeo® and Twitter;

• Burn CD’s, DVD’s or Blu-ray discs - even faster with 
multiple drives.

I have used the Roxio range of Software products for many 
years. This new revised edition is  easy to use and the quality 
of the finished product is excellent.
! ! ! ! ! ! Peter Baldwin

 TOP TIP - 
How to find Characters and 
Symbols and copy and paste 
them into your document.

It is not always easy to quickly locate 
characters or symbols which you do 
not use very often, such as the solid apple  or a fraction 
such as ½.
I find the quickest method is to type “CopyPaste” into the 
Google search box. 
If typed as one word the following site will be available as 
the 2nd or 3rd from the top of the list
http://copypastecharacter.com/
You simply click on the character or symbol and then go 
back to your document and press”Command>V” or 
“File>Paste”.

When using “Pages”, you can also find a different range of 
Special Characters in “Edit>Special Characters”.
! ! ! ! ! ! ! ! !
! ! ! ! ! ! Peter Baldwin

http://copypastecharacter.com
http://copypastecharacter.com
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What is RSS?
RSS stands for ‘Really Simple Syndication’. 
Many people describe it as a ‘news feed’ to which you subscribe. 
It is a text-based headline with a link that provides you with a 
method of getting relevant and up to date information sent to you 
as soon as it leaves your favourite news site, for you to read in 
your own time. If you’re interested in reading the whole article, 
just click on the RSS feed link, and you will be directed to the full 
article, simply and efficiently. 
It allows you to easily stay informed by retrieving the latest 
content from the sites you are interested in. You save time by not 
needing to visit each site individually. You ensure your privacy, by 
not needing to join each site's email newsletter.
To keep track of updates on a website in the “early days” of the 
web you had to “bookmark” websites in your browser and 
manually return to them on a regular basis to see what had been 
added. 
You do not have to be a technically savvy person to use RSS. At 
first I found it a little strange to make the change from 
bookmarking to RSS, but once I started I became addicted.

To subscribe to RSS feeds in Apple Mail:
• Choose File > Add RSS Feeds, or click the Add (+) button at the 

bottom of the sidebar, and then choose Add RSS Feeds.
• Browse and select a feed you’ve bookmarked in Safari, or enter 

or paste the URL of a new feed. To search feeds you’ve 
bookmarked in Safari, start typing in the search field.

• To include RSS feeds in your Inbox, click “Show in Inbox.”
• Click Add.
! ! ! ! ! ! ! Peter Baldwin

 
My encounter with “the Lion”

I use Text Edit for basic editing of 
html files for my website.
Unfortunately under Lion it behaves a little 

differently.
Now when you save an html file it automatically changes 
the file extension from html to txt.
Many other users have complained about this on the Mac 
forums so hopefully a future update will fix the issue.

In the mean time there is a free app called Text Wrangler on 
the app store which is probably a better html editor than 
Text Edit. 
    Contributed by Andrew Newton

Tip of the Day:
Lion Recovery Assistant 
Do you want to pay $75.00 for a Lion USB stick?
There is an alternative available.
Download a copy of the Lion Recovery Assistant and use it 
to build a recovery drive from your current Lion install.
The assistant works with any thumb drive with at least 1GB 
of free space. Make sure you label the drive so it will be 
easily identifiable for future use.
The Recovery Assistant does not contain a full Lion install, 
but it can save you if your hard drive fails.

       Peter Baldwin

http://support.apple.com/kb/DL1433
http://support.apple.com/kb/DL1433
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The Magic Numpad will be available later this month and 
will sell for approximately $30.00.
       Peter Baldwin

More OS X Lion Tips:
Peek Inside a File with Quick Look-
Quick Look lets you quickly preview almost any 
kind of file without actually opening it. Simply select 

a file and then press the Spacebar to preview it in 
Quick Look. 
To close Quick Look, hit the Spacebar again, press Command-Y, 
click the Close Quick Look (x) button in the upper-left corner of 
the Quick Look window, or choose File > Close Quick Look.

Working in full-screen view with Apps-
To go to full-screen, click on the little double arrow on the top 
right corner of the application's normal screen. The screen fills and 
the toolbar disappears. To get out of full screen, push the cursor to 
the top of the screen:the toolbar reappears with the double arrow, 
now on a blue background.
There is no limit to the number of full screen apps that you can 
run simultaneously and it is not necessary to exit a program to 
work in another.
Just swipe sideways with two fingers on the trackpad to get a 
different screen.
You can also resize a page from anywhere on its perimeter just by 
clicking and dragging.

 New Product available soon...
Mobee Magic Numpad

Mobee are a relatively new Company. However, in a short 
space of time they have  created a reputation for providing  
useful and user  friendly solutions to problems confronting 
Mac users. 
The Magic Numpad is able to obtain even more functionality 
out of your Magic Trackpad.
The concept is very simple. It takes advantage of the 
responsive surface of the multi-touch Trackpad to register 
taps in certain areas. 
The Magic Numpad comes with a CD containing software 
that will read where you’re touching the Trackpad and then 
translate these taps into numbers, like a normal number pad.
It also comes with three different films that stick to the top of 
your Trackpad, each with a different layout. These films can 
be removed easily if you want to try a different option. 
The software also contains options for each of these set-ups, 
allowing you to quickly type, use the Trackpad as was 
intended by Apple, or a combination of the two.

http://www.icreatemagazine.com/general/i-want-one-of-these/i-want-one-of-these-mobee-magic-numpad/attachment/screen-shot-2011-08-31-at-15-19-30/
http://www.icreatemagazine.com/general/i-want-one-of-these/i-want-one-of-these-mobee-magic-numpad/attachment/screen-shot-2011-08-31-at-15-19-30/
http://www.icreatemagazine.com/general/i-want-one-of-these/i-want-one-of-these-mobee-magic-numpad/attachment/screen-shot-2011-08-31-at-15-19-30/
http://www.icreatemagazine.com/general/i-want-one-of-these/i-want-one-of-these-mobee-magic-numpad/attachment/screen-shot-2011-08-31-at-15-19-30/
http://www.mobeetechnology.com/products/the-magic-numpad.html
http://www.mobeetechnology.com/products/the-magic-numpad.html
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5.A “Signature Capture” window will open and you will be 
looking at yourself.  Follow the instructions to create the 
signature.

6.  To insert the signature in a PDF document,  select the little 
“s” once again, click on the signature that is displayed and then 
double click on the PDF document where you want the 
signature and it will be there.

7.Signatures may be labelled and saved in Preview. 
Manage them through “Signatures” in Preview’s preferences 
pane.

! ! ! !
!
Contributed by James Strachan

! !
   

Canon adds AirPrint to Pixma printers:

Canon announced in September that 3 of its all-in-one Pixma 
printers will now support AirPrint from Apple. 

The printers are the MG8220, the MG6220 and the MG5320. 
AirPrint is the wireless printing technology Apple introduced in 
iOS 4.2, offering print services from the iPhone, iPad and iPod 
touch. 

! ! ! ! ! ! ! ! Peter Baldwin

Mac OS X Lion adds “Signature 
Capture” to Preview -

During Question Time at the last meeting I mentioned that I had 
difficulty following  instructions in the September issue of 
Australian Macworld. 
Since then David has done some research and I am now in the 
picture.

Here’s how it works-
1.  Open a blank document in “pages”.

2.  Select “Print” and in the pane that opens select 
PDF>OpenPDF in preview.

3. From the menu at the top of the PDF document  select the 
pencil icon.

4.From the lower menu that appears select the “s” icon and 
then select “Create signature from HD Face Time Camera”.

http://www.apple.com/iphone/features/airprint.html
http://www.apple.com/iphone/features/airprint.html
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We currently use the 3G BigPond 
Ultimate USB which is the fastest 
device offered by Telstra and according 
to their marketing it gives the best 
possible mobile broadband internet 
experience. 
They state that it offers typical 
download speeds from 1.1Mbps up to 
20Mbps in all capital CBDs.

I have to tell you that the service is far from satisfactory, even 
though we can see the mobile tower from our window and 
we receive full signal strength at all times. 
Quite frequently, we are unable to receive any service at all 
due to the overloading demand on the mobile towers. At 
other times the service is so slow, that it is not worth trying 
to use it.

Because of the poor service we receive, I have to state that I 
am a great proponent for the roll out of the NBN Network!

        Peter Baldwin

Long Term Evolution or LTE is the next step in the Australian 
mobile broadband revolution. 
LTE is referred to as 4G. 
The promotional material advises that it will deliver download 
speeds of up to 100 Mbps along with 50 Mbps uploads.
Telstra switched on its first 4G base stations in May and started 
selling 4g USB modems on a limited trial to business customers 
in August. The national launch is scheduled for late September, 
but coverage will initially be restricted to within 5 kilometres of 
the centre of Melbourne, Brisbane and Sydney.
The first USB devices will be dual mode 4G/3G, falling back to 
the HSPDA network where LTE coverage is not available.

This news is of extreme interest to me.

We live in Wandana Heights, which is a relatively new area of 
Geelong. 
We are unable to obtain a Broadband service. We are advised 
that we reside more that 4.8 kilometres from the nearest 
telephone exchange, being Belmont.
We have had no alternative but to resort to the only service 
available, being a 3G HSPDA service.
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 QUESTION:
Where are all the articles, Hot Tips, 
and Questions from Members?

Please help to make your Newsletter more vibrant and 
interesting by submitting items for inclusion in the 
Newsletter.

As your Editor, I cannot do it all on my own!

! ! ! ! ! ! Peter Baldwin

Email Peter....

What is macProVideo.com?
macProVideo.com is an online education community featuring Tutorial-
Videos and training for popular Audio and Video Applications including 
Adobe CS, Logic Studio, Final Cut Studio, iLife’11, iWork’09, OS X 
Lion and many more.
We several 1-month “Core Library Passes”, valued at $25 USD each to 
be distributed amongst our members as door prizes. The Pass provides 
instant access to macProVideo.com’s Online Tutorial Library, and it 
comes in an attractive fold out box.

Congratulations to new member Len Gould our first winner of this 
door prize.

! ! ! ! ! ! Peter Baldwin

Another great Mac Tip-
Check out Apple’s Online Tutorials:
Apple provides hundreds of video tutorials about Mac basics 
and Mac applications (such as iPhoto, iMovie, iWeb, 
GarageBand, iWork, and MobileMe) on its website. 
Visit www.apple.com/startpage and look for Video 
Tutorials, or just use Safari to do a Google search for "Mac 
video tutorials." 
You'll find more video as well as text tutorials at 
www.apple.com/findouthow/mac that include additional 
topics, from "Get Started with Mac" to "Using iChat."
! !

! ! ! ! ! ! Peter Baldwin

mailto:peterbaldwin@bellarinemac.org.au?subject=
mailto:peterbaldwin@bellarinemac.org.au?subject=
http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQrkdQzczgNEOQGQaQ7cKVXtpKX%3DSRDRYUBU&_ei_=8312wfG0Xb9X%3DBzgC87YTUqTCGDqW8zg7qCTUzgq7UYzg9RAABRDDVGf6beX6990G11X%3DiLlLjIHtKOpgTRRRxPHohhQJhuQHm.
http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQrkdQzczgNEOQGQaQ7cKVXtpKX%3DSRDRYUBU&_ei_=8312wfG0Xb9X%3DBzgC87YTUqTCGDqW8zg7qCTUzgq7UYzg9RAABRDDVGf6beX6990G11X%3DiLlLjIHtKOpgTRRRxPHohhQJhuQHm.
http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQrkdQzczgNEOQGQaQ7cKVXtpKX%3DSRDRYUBD&_ei_=8312wfG0Xb9X%3DBzgC87YTUqTCGDqW8zg7qCTUzgq7UYzg9RAABRDDVGf6beX6990G11X%3DiLlLjIHtKOpgTRRRxPHohhQJhuQHm.
http://e.pearson.info/pub/cc?_ri_=X0Gzc2X%3DUQpglLjHJlTQ4rQGyy4QiosJQrkdQzczgNEOQGQaQ7cKVXtpKX%3DSRDRYUBD&_ei_=8312wfG0Xb9X%3DBzgC87YTUqTCGDqW8zg7qCTUzgq7UYzg9RAABRDDVGf6beX6990G11X%3DiLlLjIHtKOpgTRRRxPHohhQJhuQHm.
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Take Control of Using Lion
  Author: Matt Neuberg
! ! Publisher: TidBits Publishing,Inc.!
! ! Pub. Date: July 2011
! ! Pages: 167, ebook-PDF format

This ebook instructs you on how to use your 
Mac to get the most out of the new features in  OS X 10.7 
Lion, especially in terms of customising the Operating 
System to suit your personal preferences. 
One of the great features of this book are the Quick Start 
pages. These pages, which link to specific sections in terms 
of typical users and what they’re most likely going to want 
to accomplish first, are extremely useful. 
The directions to set up the Dock and System Preferences, 
especially the suggestions about making text easier to read 
and work with, work particularly well in terms of making 
every other aspect of using Lion much more pleasant and 
efficient. 
The succinct commentary about which new Lion features are 
particularly innovative, and ways of using them are equally 
useful, and easy to follow. 
You will find answers to many questions and learn how to 
take advantage of the numerous new features offered in 
Lion.

Go to “oreilly.com” and you can purchase these two Ebooks 
for the price of one by using the Discount Code DSUG2
    
      Review by Peter Baldwin

Take Control of Upgrading 
to Lion, Version 1.1
  Author: Joe Kissell
! !
! ! Publisher: TidBits Publishing,Inc.!
! ! Pub. Date: July 2011
! ! ! Pages: 150, ebook-PDF format

This book explains what to do before you start upgrading to 
Lion, how to upgrade effectively, what to do if your upgrade 
has a problem, and how to get a smart start once the upgrade 
is completed. It is a handy reference guide whether your 
upgrade is fairly straightforward or  quite complicated. 
It is  very easy to read and it clearly and concisely explains 
each step of the process.
Because Lion is such a major change from previous 
operating systems, it’s important to get the upgrade process 
right the first time. 
It covers areas such as backing up the hard drive, deleting 
unnecessary and rarely used programs, making sure your 
Mac can run Lion, and deleting Rosetta.  

It is not designed to be a book on how to use the new 
features in OS X Lion.
     Review by Peter Baldwin

http://oreilly.com/
http://oreilly.com/
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BMUG Assist program
This program is available to ALL members and will attempt to 
resolve urgent Mac problems. 
Jürgen will be available to take your call on 5255 4517 to help if he 
can or to give you advice about who can.

HelpDesk
This valuable part of our program operates at every 
meeting. Please book in advance by email — this gives 
Jürgen Gross and the volunteers time to research your 
issue in advance. 
                          
BMUG manuals - still available
All manuals are still be available for sale over the counter at our 
monthly meetings for $5 each (while stocks last).
However, as previously advised, the manuals will no longer be 
updated and therefore will have no reference to the newly released 
Operating system - OS X Lion. 
These manuals will soon be available as free downloads from our 
webpage to members only. 

Additional help for remote members
For non-urgent matters, why not write an enquiry to Aunty Mac? 
She and the helper elves can usually provide a solid answer.

New Members Welcome
We welcome all Mac Users. What are you waiting for?
Web: www.bellarinemac.org.au

email: info@bellarinemac.org.au

Make a  
HelpDesk 
booking...

Members’ marketplace
For sale — 20 inch iMac OS X 10.6 Snow Leopard

Bought 3/6/2008
Processor 2.66 GHz Intel Core 2 Duo
2 Gb 800 MHz  DDR2 SD Ram
320 GB Hard Disk

Asking Price $650.00

Contact Bryan Addison at -
bad75673@bigpond.net.au
or Ph. 03 5258 1611 Mob. 0427 581 611

For sale — 24 inch iMac OS X 10.6.8 Snow Leopard

Processor 2.4GHz Intel Core2 Duo
4GB RAM  667MHz  DDR2  SDRAM
640GB  Hard Disk
iLife 11 (iPhoto, iTunes, Garageband, 
iDVD, iWeb)
iWork'09 (Pages, Numbers, Keynote)
I can also offer Photoshop CS2 or 
Photoshop Elements if you are 
interested.

This computer has a larger than normal Hard Drive, 640GB 
instead of 320GB and it also has 4GB of RAM as against the 
usually fitted 2GB. 
The Hard Drive has been completely erased and everything newly 
re-installed.

Asking Price $900.00

For further details contact; Dick at -    
 foleymay@bigpond.net.au   
or  Ph. 52591614

Email 
Aunty Mac

http://www.bellarinemac.org.au
http://www.bellarinemac.org.au
mailto:info@bellarinemac.org.au
mailto:info@bellarinemac.org.au
mailto:help@bellarinemac.org.au?subject=
mailto:help@bellarinemac.org.au?subject=
mailto:help@bellarinemac.org.au?subject=
mailto:help@bellarinemac.org.au?subject=
mailto:help@bellarinemac.org.au?subject=
mailto:help@bellarinemac.org.au?subject=
mailto:bad75673@bigpond.net.au
mailto:bad75673@bigpond.net.au
mailto:foleymay@bigpond.net.au
mailto:foleymay@bigpond.net.au
mailto:peterbaldwin@bellarinemac.org.au?subject=email%20subject
mailto:peterbaldwin@bellarinemac.org.au?subject=email%20subject
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David Dixon,
President, 

Manuals Printing,
Hall Bookings. 

Prue Paterson,
Web Manager
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Peter Oakley,
Membership Assist.

Greg Melville
Meetings Manager, 
Hall & equipment

Co-ordinator.

Jürgen Gross,
BMUG Assist 
Co-ordinator,

Help Desk Co-Ordinator.

Ian Little
Treasurer.

Peter Baldwin,
Vice-President,

Library Co-ordinator,
Newsletter Editor.

Pat Hollis
Secretary,

Membership.

Get to know the members of your BMUG Committee...


